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From the Editor

Belkin buys Linksys from Cisco
Ongoing tie-up means Cisco’s not entirely free of
low-end business. Cisco has found a buyer for its
unwanted and unstrategic Linksys low-end networking
brand, in the form of accessories and small networks
player Belkin.
http://tinyurl.com/b6d27aq

This will be the last mailing from the old mailing list.
Starting with the April issue only the members that have
signed up for the mailed copy will receive it.
I have used the old list to be sure everyone that paid
the extra charge received the mailed copy. The members
dues should have been paid in January.

BUYING A MAC
I was just having a conversation with someone
who is about to buy a Mac. I was against it and an
argument started. I said there were too few people
supporting the Mac.
He responded, "When was the last time you
heard of a virus on a Mac?"
And I said "See, even people who write viruses
don't support Macs."
Have you heard about the lawyers word
processor?
No matter what font you select, everything comes
out in fine print.

Outsourced his job to China
A security audit of a US critical infrastructure company last year revealed that its star developer had
outsourced his own job to a Chinese subcontractor and
was spending all his work time playing around on the
internet.
He was paying them a fifth of his six-figure salary to
do the work and spent the rest of his time on other
activities. Bob is no longer employed by the firm.
http://tinyurl.com/a54l8fk
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THE NEXT MEETING OF THE
BREVARD USERS GROUP
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March 6th, 2013
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Fee Ave
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Visitors welcome!

T The BUG Newsletter is created on a AMD Athlon
XP 3100 Mhz computer using PageMaker 6.01, on
Windows XP.
Articles, Reports, and new Advertisements should
reach the Managing Editor or Desk Top Publishing SIG
by 5:00 p.m the Friday before the second Wednesday
of the month. Items received after the deadline will be
held for the following month’s issue.
The articles contained in this Newletter do not
necessarily represent the opinion of the Group, Editor,
or Publisher or any other person other than the author of
the article. The Brevard Users Group does not support
or condone illegal copying of software.
Permission is granted to copy articles, provided the
source is disclosed and proper credit is given to the
author.
All questions, correspondence, and other items
pertaining to the Newsletter should be directed to one of
the Editors.
Questions involving advertising should be directed
to Advertising at the address below.
Articles or items of interest for inclusion in the
newsletter should be sent to The Editor at:
Brevard User’s Group
PO Box 2456
Melbourne, Fl. 32902-2456 or
Jim Townsend
728-5979
E-mail to: newsletter@bugclub.org
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Visit the BUG CLUB web site
for the latest schedule.

http://bugclub.org
ELECTRONIC WHOLESALERS
ASTRO TOO
Appliance Parts - Electronics Recycling
Surplus/Electronics Equipment/Parts
Surveillance Equipment / CCD Cameras
Computer Sales & Service
3060 Dixie Highway NE (US1) (321) 727-9010
Palm Bay, FL
(321) 727-9709
http://astrotoo.com EMail: 2@AstroToo.Com

Attention
Newsletter Editors
This publication is produced by:
Creative Technology of Sarasota Inc.
The same printer used by many user groups, local
churches, mobile home parks, and many others at
affordable rates.
Creative Technology prints, folds, addresses, and
mails newsletters for your club, organization, family or
business from a ”pdf format” sent by e-mail or disk,
saving you lots of time and expense.
Contact Bob today to see how much money we
can save your organization. E-mail bob@ctimls.com
Creative Technology of Sarasota Inc.
5959 Palmer Blvd.
Sarasota, FL 34232
941-371-2743
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Secretary’s Report

Treasurer’s Report
By: Tom English

By: Bill Middleton

January 2013

No report this month

EXPENSES
Printing
Equipment
(new computer)
Total

$477.67

By Tom Allen, Publisher / Editor, Mountain Computer
User Group, Georgia
May 2012 issue, Mountain Bits & Bites
www.mcug.org
bunkerhilltom (at) yahoo.com

INCOME
Dues
Tinkers SIG
Interest
Total

$ 787.00
$ 245.00
$ 0.08
$1,032.08

Many of you get your mobile phone wet by one way
or another. You worry as you mistakenly drop your
mobile phone in water. It can also get wet if you are out
in a heavy rain. However, there is no need to panic. It is
possible to save your wet mobile phone by quickly
repairing it. In order to save your mobile phone from
water damage, you can consider doing this:

ASSETS
Checking
Savings
Total

$1,296.34
$2,024.34
$3,320.68

What you can do if your mobile
phone gets wet

The most important thing you have to do is to act
rapidly. Quickly remove all the detachable parts as well
as covers possible such as the back cover, battery, the
SIM card, memory card etc.
Next, take a piece of cloth or a tissue paper to wipe
the excess water you are able to notice within the mobile
phone. Make sure that you dry it completely. If you
don’t do this, the water inside the mobile phone will
begin to evaporate and gather in places which will be
difficult to reach.

$ 65.74
$411.93

Why disc drives are an
endangered species
“While it may be too early to say for certain that the
optical drive is absolutely dead,” wrote Chris Pirillo,
founder of blogging network Lockergnome, “it is certainly showing all the early warning signs of a technology
that is past its prime.”
Read More: http://tinyurl.com/a7jsk27

Take a hairdryer and begin drying the mobile phone
Happy birthday, Lisa:
while giving more consideration to the place where the
battery is located. The battery housing usually consists of
tiny holes to let in air (so giving more space for water)
Proposed in 1978 and in development since 1979,
inside the mobile phone. It will take several minutes. You the Apple Lisa went on sale on 19 January 1983 for
may also set your oven to 180 degrees and let it preheat $9,995.
(if you are brave!). Turn it off, open the door and set the
phone in it for about half an hour. I have done this but
http://tinyurl.com/a3849d4
watched it very carefully and the phone survived.
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The Amazing PIXEL
Jim Cerny, Director, Sarasota PCUG, Florida
October 2012 issue, Sarasota PC Monitor
www.spcug.org
jimcerny123 (at) gmail.com

Years ago my daughter had a toy called “Lite-Brite”
where you made your own “digital” image by putting
colored plastic pegs into a black board that had a light
bulb behind it. We had to view it in a dark room to see
the colorful image. It was crude, but each peg really was
a “pixel.” You probably have heard the term “pixel”
before, especially if you have purchased a digital camera. But what exactly is a “pixel” anyway?And what do
you really need to know about it?
As technology furiously changes everything we are
comfortable with (and leaves us in the dust with the
dinosaurs) it introduces many new words into our
vocabulary. There is no better example of this than how
digital photography and computers have changed the
way pictures are taken, stored, viewed, shared, edited,
and printed. Goodbye film, goodbye Brownie camera
(remember them?) and hello digital and hello pixel.A
brief definition of a “pixel” would be: the smallest
element of a digital photograph or image which has only
one specific color.
So a digital photograph is composed of pixels.
Millions of them. Each pixel (usually a tiny square in
shape) can be only one color. Digital photos are usually
measured by the number of pixels, either the total
number of pixels in the photo (such as an 8 mega-pixel
photo) or by the number of pixels horizontally and
vertically (a 1,000 by 1,000 pixel photo is the same as a
1,000,000 or 1 mega-pixel photo). The greater number
of pixels the higher the resolution of your photo. Usually
more expensive cameras give you more pixels in the
photo, and this is a good thing. The number of pixels per
photo that your camera is capable of is shown on the
front of the camera. When you take a photo, each pixel
is saved in computer memory with its exact location in
the photo and its specific color out of about 16 million
colors possible. (By the way, I believe the human eye
can distinguish around 10 million colors, so our technology used here is already beyond our sense of sight). No
wonder a single photo can take up many times the space
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of a document in computer memory! It is at this point
that I want you to imagine a “Lite-Brite” toy the size of a
football field and a choice of about 16 million colors for
the pegs. Work as fast as you can to create an image.
And, so you don’t forget, write down the exact location
of each peg and the color you selected. You will need
this information to copy or do anything with your image.
This is basically what a digital camera does in a fraction
of a second when you press the button.
To see a single pixel, try opening a photo on your
computer (go to “My pictures”, find a photo and
double-click on it with your left mouse button to open it
– it will probably open in the “Windows Photo Viewer”
program if you are using Windows 7). When you are
viewing a picture in a program look for a magnifying
glass icon or click on “view” to get to a zoom option for
your photo. If you zoom in far enough you will see the
small squares that make up your photo – each square is
a pixel. So, if your photo has a curve or an arch in it and
you zoom in far enough you will see that the curve is
really made up of tiny squares. So in this sense, computers really are “squaring the circle”!
How you view or look at a photo is dependent upon
the hardware device (monitor or printer) or the software
program (Windows Photo Viewer, Adobe Photoshop,
Picasa, etc.) you use. Fortunately today both monitors
and printers are very capable of dealing with highresolution photos.
I guess the bottom line is that we will let the computers and the printers do their magic and we won’t worry
about pixels at all. But here are a few tips that may help
anyway:
1. Always save the original photo before you start
messing with it. Only play with a copy.
2. If you crop a photo you are deleting the pixels
you do not want. The cropped photo will have fewer
pixels and take up less computer memory space.
3. Reducing the size of a photo may be helpful if you
want it to take up less computer memory. Suppose you
reduce the photo to 25% of its original size. That would
mean that you are replacing four pixels with one pixel.
You will have lost resolution but your photo will now
take up only 25% of the computer memory space as the
Continued on Page 6
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Pixel ,,, Continued from Page 5
original. Why would you want to do this? Well, it is
easier and faster to send them in emails and also many
more photos can fit into those “digital picture frames”,
on CDs, and on those little “thumb” drives.
4. You can print an image almost any size you want
but you cannot “add pixels” to the image and get more
resolution. (But I bet there are some programs out there
that can do a good job of trying this trick.)
If you want to find out more information, go to
Google, of course, and enter “pixel”. If you have lots of
time on your hands, you can pretend that you are a
digital camera — just find one of those old “Lite-Brite”
toys and make your own picture. It gives you a whole
new appreciation for technology, doesn’t it?

Have Fun and Learn with
PAINT
Jim Cerny, Director, Sarasota PCUG, Florida
November 2012 issue, Sarasota PC Monitor
www.spcug.org
jimcerny123 (at) gmail.com

Feed your creative side! Learn a little about computer graphics.
I’ve always liked the Paint program — it comes free
with Windows. Sure, there are other drawing and
graphic programs you can use, many of them free on the
internet, but since everyone who has Windows has the
Paint program, you might want to know a little about it.
To open Paint on your computer click on the “Start”
button in the lower left of your screen, then move your
mouse to “All Programs” and a list of your computer
programs will be displayed. Scroll down to the “Accessories” folder and click on it. In the list of programs in
the Accessories folder find “Paint” – click on it once and
it will open. You can play with Paint and make your own
drawings and you can open a photo in paint and then
draw or put text right on the photo. But before we do
that, let me tell you why I like the Paint program and
why I think it is worth your time to learn about it.
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Paint is an excellent program for new computer
users because it can teach you some basic computer
commands for doing graphics. You can draw and work
with shapes, colors, lines, pictures, and more. But the
important thing is that what you learn in Paint will come
in handy in many other graphic programs. Paint is also
an easy program to learn on your own by using its own
“help” option. When you open Paint (in Windows 7),
click on the little blue circle with the tiny white question
mark in the upper right corner of the window (or just hit
the “F1” key on your keyboard). Then click on the
article title you want to learn about. I suggest starting at
the top and read all the sections if you have not used
Paint before. Don’t worry, the entire help article is not
long and you can read it all in less than a half hour. But
you really need to actually do what the instructions tell
you so that you will build up your computer skills. The
program is simple enough to learn easily and it will
introduce you to some great computer graphics. But, on
the other hand, Paint is limited in what it can do. For
example, it is not intended to be a complete photo
editing program by any means.
Play with Paint for a while and learn how to draw
and change shapes. Select different colors and draw
some lines, circles and squares (to draw perfect circles
and squares, hold down the “shift” key while you drag
your mouse to create the shape). Try selecting different
brush types – you can select oil or water color, for
example, or crayon or marker. Notice how you can see
“through” some colors to the others underneath (Paint
prior to Windows 7 does not have this feature). Now
draw a text box by clicking on the text tool which is a
capital letter “A”. In the box will be the insertion point
ready for you to type your text. You can make the box
“transparent” or “opaque” and move it wherever you
want. Make a mistake? – just click on the “undo” arrow,
the small blue arrow curving to the left at the very topleft of the Paint window.
One thing Paint can do is allow you to put text right
in your photo. If you click on “help” you will see the
“Adding text” title – click on it to learn how. But let me
step you through this, one step at a time (in Windows 7),
to introduce you to this:
Continued on Page 7
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9. Select a color for your text. Pick a color from the
color pallet that will stand out on the photo, such as
1. Open the Paint program (see instructions above).
yellow. Just click on the color you want and that color
should then appear in the “Color 1” box. This will be
2. Click on the dark blue rectangle in the upper left
your text color.
of the window. This used to be the old “file” menu but in
10. You can select other text options if you wish,
Windows 7 the word “file” is gone. (No, I don’t know
such as bold, italic, or a different font. Also, select if you
why they removed the word “file”!).
want your text box to be transparent (my choice) or if
you want it to be “opaque” (that is, to have a back3. Click on “Open” which will display a window in
ground color). The background color will be the color in
which you can find the photo you want to work with in
the “Color 2” box which you can change if you want by
Paint. Click on the photo and click on “Open” at the
clicking on that box. If your text color and the backbottom right of the window. The photo will now be in
ground color are the same, you will see no text!
the Paint program window – but wow — look how big
11. After you type your text you can still move the
it is!
box to where you want by dragging it. Once you click
4. Why so big? Well, I guess the Paint program is
outside the box, that’s it, your text is now part of the
used to dealing with images with fewer pixels, but it’s no
photo and the box is gone. If you make a mistake, just
big deal – let’s zoom out to see the whole image at once.
click the “undo” blue arrow at the top left of the window
Click on the “View” tab and then click on the “Zoom
and you can try again.
out” tool until you see the whole image in the window.
12. Save your photo with a NEW NAME. Click on
Now we can work with it much more easily.
the blue rectangle again (the old “file” menu), move your
5. Click on the “Home” tab and then click on the
mouse to “Save as…” and then click on your file type
“Text” tool – this is the large capital letter “A” in the
(probably “.jpg”). In the window that opens, pick the
“tools” section of the Home tab ribbon. You are now
folder into which you want to save your photo and enter
ready to draw a rectangle in which you will type your
a good name in the name box. Click “Save”. If you do
text.
not give it a new name it will replace your old photo
6. On the photo, drag your mouse (hold down the
which will be lost.
left mouse button) to draw a rectangle. If you draw it in
the wrong place, just move it to where you want by
I think you will enjoy using the Paint program, let it
dragging it with your mouse. You can also change the
bring out the artist in you. While you are drawing your
size of the rectangle by dragging the little white “handles”
masterpiece, you will be learning some very helpful
at the corners or sides. Try it!
computer skills. Computer graphics can really do some
7. When you draw this rectangle, the “Text” or “Text
amazing things and there are several programs free on
tools” tab is opened for you. This is where all the text
the internet if you want to do more. So have fun and get
editing tools are, and there are not that many.
colorful!
8. The “insertion point” is already in the rectangle
ready for you to type your text – but wait a second,
where is that insertion point again? It is in the upper left
of the rectangle you drew, but it may be VERY tiny!
Can you even see it? The Paint program had no idea
how large your photo was going to be so the larger (i.e.
more pixels) your photo is, the smaller the font will
appear. Remember, we zoomed out to see the whole
photo. So, get the font larger by clicking on the little
black arrowhead next to the number in the “Font” tool
area and pick a big number, say “72” and see how big
that is. You can enter numbers larger than 72 if you want
by using the keyboard.
Paint ... Continued from Page 6
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Windows 8 – A first look
From the HAL-PC, Texas, Senior Learning Center
www.hal-pc.org

Since Windows 8 looks and acts differently from
Win 7, it is the subject of many questions, and possible
misinformation. Volunteer teachers are busy discovering
as much as they can, as fast as they can so they can be a
knowledgeable resource. Below is a summary of what
they have learned thus far, which would be relevant for
their Senior Learning Center audience.
The new Windows 8 operating system was designed
for use with multiple devices such as Windows phones,
laptops, tablets and desktops which may or may not
have touchscreens. Basically it is a new user interface or
UI that runs on top of an “improved” Windows 7.
Programs, now called apps, appear as active tiles/icons
and applications (apps) such as you might see on a
smart phone display. At one time this opening screen
was called the “Metro” interface. The vertical group of
icons on the right, dubbed the Charms bar, provides
access to “Searches” at the top and to “Settings” at the
bottom. One of the tiles is labeled Desktop (lower left).
When clicked, it reveals a familiar, yet different XP or
Win-7 desktop view with the familiar Windows Explorer
(now called File Explorer) and Control Panel. It does
incorporate the “Ribbon” interface which was introduced with Office 2007. However there is no Start
button.
VERSIONS OF WINDOWS 8
There are several variations of the new Operating
System (OS) for consumers: (1) Win-8, (2) Win-8 Pro,
and (3) Windows RT. Windows 8 and Windows 8 Pro
will run any current software on Win-8 PC desktops,
laptops, net books, and some tablets. The main differences between these two systems are that Win 8 Pro
accommodates Windows Media Center and also will
allow encrypted back-ups. It is considered the “business” version. Windows RT will only run on Microsoft’s
new Surface tablet and other tablets that PC firms are
developing in competition with Surface.As with any
tablet, the Surface will not run current Microsoft software such as Office 2010, or 3rd party software such as
picture editing programs like Adobe Elements. However,
a new Office 2013 is included with the purchase of the
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Surface tablet. All other apps must be downloaded from
the Microsoft store, a la Apple. Other vendors will
eventually have competing hardware and programs that
will run with and on Surface. It should be noted sometime after the first of the year Microsoft will be coming
out with the Surface Pro which will be more like a net
book or any other small portable computer.
PROGRAMSAPPS
As previously mentioned, there is no Start Menu
with Win-8 as with previous Microsoft OS’s produced
since Win-95. There is a “Start Screen” on which
programs are displayed as “apps” (applications).
Example: Office 2010 Word, Excel and Power Point
will be displayed as separate apps as will be 3rd party
programs. Since these run on the desktop side of
Windows 8, they are now known as “Desktop Apps”.
Depending on your hardware, they are called into use by
a touch or by mouse click to the desired icon on the
Start Screen which will take you to the Desktop side.
Features found in Win-7 Accessories, such as the
Calculator, WordPad, Paint and Snipping Tool are now
found as apps. Several features available in Win 7 have
been deleted. Examples: Gadgets, Aero Glass, DVD
Maker and Flip 3D. Some may be still available as apps
from the Microsoft store.
UPGRADING
Those who are considering upgrading their current
OS to Win-8 will find that a single upgrade disk will
upgrade XP, Vista and Win-7 regardless of the version.
The upgrade package contains both 32 & 64 bit disks.
When upgrading it will let you know which disk to use.
AND IN CONCLUSION….
It’s important to understand that Win-8 is a work in
progress just as all operating systems have been in the
past, whether it be MSoft, Apple, or Google’s Android.
What we know about Win-8 will undoubtedly change as
we move into 2013. Please stay tuned.
As a last note, if you shop for a new machine, do
not be surprised if you receive different answers to the
same question asked of the sales force at the local retail
stores. Everyone is faced with a learning curve with
Win-8.
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Two Useful Tools for Improving
Documents

If the English Thesaurus doesn’t satisfy my search, I
can click the arrow next to Thesaurus and choose
another of several reference books, such as dictionaries,
translators, and Thesauruses for other languages. I can
Nancy DeMarte, Regular Columnist (Office Talk),
also add new reference books to my research choices
Sarasota PCUG, Florida
by clicking “Research options” at the bottom of the
November 2012 issue, Sarasota PC Monitor
Research pane and putting checkmarks next to those I
www.spcug.org
ndemarte (at) Verizon.net
want available. These include specialized books, such as
the Foreign Word Spelling Look-up, Dorland’s IllusWord provides good tools for correcting mechanical trated Medical Dictionary, and Thomson Gale Company
errors in documents, but sometimes I find I want to
Profiles.
improve the writing quality of the document, which I do
Find and Replace
in the revising stage. Here are a couple of tools that I use
Another bad habit writers have is redundancy; we
to clarify meaning and eliminate redundancy. These tools tend to repeat words or restate ideas. My favorite tools
are available in many versions of Word, although my
for fixing this problem are Word’s Find and Replace
descriptions here are based on Word 2010.
commands, located on the Home tab in the Editing
group. Click Find (the binoculars icon) to open the
Thesaurus
Navigation pane or use the shortcut Ctrl+F (hold the
When I can’t think of a word which says precisely
Ctrl key and press the F key). Because I use this tool so
what I mean, I turn to Word’s Thesaurus. It is located
often, I have pinned the Find tool to the Quick Access
on the Review tab in the Proofing group on the Word
toolbar above the ribbon. Any command I use often is
2007/ 2010 ribbon. I prefer to open it by highlighting the on that toolbar.
word I want to improve, then using the keyboard
The Navigation pane offers a quick way to find out
shortcut, Shift+F7 (Hold Shift while pressing F7). This
how many times I’ve used the same word in a piece I’m
opens the Thesaurus in the Research pane as a sidebar
writing. For instance, I just searched this article for the
of the document window, and shows my word’s synword, “word”, and was blinded by all the yellow highonyms arranged by context.
lighted “words” in the document. Besides locating and
highlighting each instance, the Navigation pane also
For example, when I select the word, “press,” and
displays the sentence portion surrounding it. I realized
press Shift+F7, the US English Thesaurus opens and
that I needed to reword (oops, I mean rephrase) some
reveals eight context categories: media, crowd, surge,
sentences to eliminate those annoying repetitions.
pressure, pursue, iron, push, and pursue (legal), each
with a list of 6-8 synonyms below it. Almost always, I
can find a word among those listed that fits my need. Pi

Continued on Page 10
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Useful Tools ... Continued from Page 9
Searching using the Navigation pane is a simple way
to find repeated words, but it has limitations. What
about the situation where “Word” is capitalized because
I’m referring to the computer program? I may not want
to include these in my search. Here’s where I need to
open the “Advanced Search” so I can set some parameters. To do this, I can click the arrow next to Find on
the Home tab or the arrow next to the search box on the
Navigation pane and select Advanced Search. What
opens is the traditional Find and Replace dialogue box,
which offers some interesting filters for searching. Here I
can set some rules for my search by clicking “More.” I
put a checkmark next to “Match case” so that my lower
case “word” search would not target upper case
“Word.” Another helpful filter is, “Find all word forms
(English),” which would have highlighted “words” and
“worded,” along with “word,” in my earlier search.

Coming Soon:
Microsoft Office 2013
Nancy DeMarte, Regular Columnist (Office Talk),
Sarasota PCUG, Florida
October 2012 issue, Sarasota PC Monitor
www.spcug.org
ndemarte (at) Verizon.net

“Oh, no,” you say. Not another new version of MS
Office, just when you were getting used to the 2007 or
2010 versions. Calm down. This version is both very
much the same and very different from previous versions. If you’re comfortable with the newer Office suites,
it’s not at all a problem to learn. The main differences
are found not as much in the specific programs as in the
overall look and purpose of the suite. Office 2013 is
designed to be compatible not only with PC’s, but also
with the new devices that Microsoft is rolling out, like
The Replace tool is a natural complement to Find,
the Windows phone and its new tablet called Surface.
although in my writing I rarely use it. It has its own icon
on the Home tab and its own tab behind Find in the Find To compete with rivals Google andApple, Office 2013
and Replace dialogue box. What it does is let me find all is also highly integrated with Microsoft’s cloud area,
SkyDrive.
the instances of a word, and then replace all of them
with another word. If my goal is to vary my word
choices, replacing all instances of a repeated word with
An Office 2013 preview came out in mid-July. The
another isn’t something I want to do. However, if I had
reviews I read from the tech writers were quite positive,
a long document with, for example, a misspelled unusual
which made me decide to download the preview and
proper name like Abernathy, and I had spelled it
give it a look. I was immediately impressed with most of
Abernethy, then using Replace makes sense.
the changes that have been made to the programs of the
suite (Word, Excel, PowerPoint, Outlook, etc.), some of
Newer versions of these tools allow us to find and
which will be discussed below, but the overall appearreplace graphical elements, tables, punctuation, formatance took some getting used to. They call the new look
ting features, and font properties, such as changing all
Metro, which means a cleaner, more modern design.
instances of a word in text to bold or italicized. These
The text on the ribbon is simpler, less ornate than in
two tools not only save time, but can actually improve
previous versions. And it is easy to hide the ribbon
the quality of writing. That’s not a bad thing in this age of
details and toolbars, leaving only the tabs. There is much
texting. FWIW IMHO
more white space, giving a less cluttered feel. And if you
use Office 2013 on a touch screen device, even more
white space opens up for easier touching. I found I
could accomplish more in Office 2013 with fewer clicks
than in Office 2010..
“Why does Sea World have a seafood restaurant? I’m halfway through my fish burger and I
Besides a cleaner look, the other big focus of the new
realize, Oh my Goodness. I could be eating a slow
Office is storing files on the Internet, where they can be
learner.”
accessed from and synced with other devices no matter
-Lynda Montgomery
where you are. This is certainly the future of computing.
Continued on Page 11
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Office 2013... Continued from page 10
For example, the default saving location in Office 2013
is no longer “My Documents,” but SkyDrive. It took
just two clicks for me to save a document to my
SkyDrive location. If I edit it there, the changes will
sync with the same file on my PC.
Another general change is the demise of “add-ins,”
which are optional downloads that provide extra
features to Office programs, like the International
character toolbar. Instead, Office 2013 will offer “apps”
from a new Windows Store, much like the app store in
Apple’s iTunes. Apps stay on the host website so they
can be accessed from any device at any time.
Program changes:
Microsoft got quite a bit of resistance to the ribbon in
Office 2007, so changes within the new Office programs have been few, but useful. Here are a few of my
favorites:
Word 2013 has added the ability to edit PDF documents, a real time-saver. In versions 2007 and 2010,
you could save a document as a PDF, but it was “read
only.” If you wanted to edit it, you had to save it as
another file type, like a .docx, then re-save as a PDF.
Read Mode (different from Reading Layout View)
displays a document in landscape orientation (wider
than it is tall) and removes all the toolbars and rulers to
maximize the reading area.As I know from my iPad
experience, this is something especially suited for mobile
devices. Another upgrade is the ability to insert online
video from within a document.
The move to make things simpler for Office users is
represented by the new, updated templates found in
Word, Excel, and PowerPoint. When you open the
program, a group of templates appears on the screen,
ready to be used. Many more are available online. One,
of course, is a blank document or spreadsheet or slide.
Excel 2013 has a couple of helpful changes. For
example, it includes a Recommended Charts button.
Selecting a group of data and pressing this button will
show a short list of charts best suited to display your
type of data. Flash Fill will sense that you are performing repetitive actions and complete them for you, as
long as the data is in the same form.
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PowerPoint 2013 has new, updated themes. This
pleased me because some of the themes had been in
existence since the early 90’s and had become a bit stale.
Another nice upgrade is the Presenter view, where the
presenter can see on his laptop not only the projected
slide, but a small version of the slide before and after, not
visible to the audience. The Zoom feature lets the presenter zoom in on a graphic or text on the screen during
a presentation.
The Outlook 2013 email program can display your
Facebook or LinkedIn accounts at the bottom of the
screen. The new Peeking feature opens a mini-window
as you are composing an email so you can refer to your
calendar or contacts list without having to open another
program to get information.
All in all, I like Office 2013. Much of what exists in
Office 2010 is still there, and the new feaures helped me
complete tasks more efficiently. After a small period of
adjustment, I like the modern look. I have had no trouble
saving documents to my SkyDrive area and really
appreciate the advantages of accessing files on multiple
devices. The one feature that I haven’t yet been able to
get used to is the change in the Save As window. To save
a document to My Documents, I had to go through four
clicks: Save As – Computer - Browse – My Documents.
If I save to SkyDrive, the clicks are reduced to two:
SaveAs – SkyDrive. Perhaps before the actual Suite is
released, that problem might be fixed, or maybe there is
an easier way that I have yet to find.
According to Microsoft, Office 2013 will not run on
Windows XP or Vista; it will run on Windows 7 and 8,
but is designed to integrate best with Windows 8, which
itself is advertised as being compatible with mobile
devices of all kinds. Windows 8 is scheduled to go on
sale October 26, 2012. Office 2013 won’t be released
for a year or so. It will have several versions for home
and business, and claims to have versions compatible
with Mac and open-sourced formats. Pricing has not
been set.As a reviewer said, “It will cost more than
Google Docs, but it has many more features.” Anyone
can preview the suite by going to:
http://www.microsoft.com/office/preview. Don’t be
confused. The download will be called Office 365, which
is the subscription-based version of Office 2013.

http://bugclub.org

11

Introduction to Computers
By Brian Aldridge, President, Idaho PC Users Group
November 2012 issue, Bits and Pieces
www.BiteOfTech.com
www.idahopcug.org
brian (at) idahopcug.org

Computers are incredibly powerful tools in today’s
society. They are able to perform calculations requiring a
vast amount of information in mere seconds while also
being able to carry out other tasks by the user.
What is a computer?
If you look in the dictionary printed before 1940,
you might be surprised to find a computer defined as a
person who performs calculations. Machines also
performed calculations back then, but, they were
referred to as calculators, not computers. Today a
computer can allow its user to complete incredible tasks
and projects in a quick and efficient manner, while also
making the output look professional. The computer is
the 21st century’s most powerful tool for both the home
and the office and is becoming more and more popular
as units become more and more inexpensive.
Learning to use computers is a challenging experience, but also a rewarding one. The computer is a very
valuable and powerful tool that is changing in performance and usage on a daily basis. Software packages
are changing and becoming more power to keep up with
society’s demands. Today, almost anything is possible to
with a computer, and tomorrow brings even more
promise.
When I use a computer system, what components
could it include?
Monitor - The primary output device on a microcomputer. It is the screen.
Case - The box that contains the main circuit board
of the computer system.
Hard Disk Drive - Stores billions of characters on a
non-removable disk platter inside of the computer
system.
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Keyboard - The primary input device. It includes
the letter and number keys as well as several additional
keys to control computer-specific tasks.
Mouse - A pointing device that you use to manipulate objects on the screen.
Power Supply - Unit that provides power to the
entire computer system.
Fan - Controls airflow through the case.
IDE/SATA Cable - Connects HDD, CD/DVD
Drive, and similar devices to the motherboard.
CD/DVD Drive - Unit that can read and possibly
write removable digital media.
Memory - Stores commands from user for immediate processor use Motherboard The motherboard
houses all connections to all system unit parts. (i.e.
HDD, Memory, CD/DVD Rom, etc.)
Sound Card - The sound card is an add-on card
that when connected to the motherboard can allow a
speaker, microphone, joy stick type connection to the
computer.
Video Card - The video card is an essential add-on
card that provides a connection between the monitor
and the motherboard.
NIC - A NIC (Network Interface Card) provides a
connection from the network router/hub/switch to the
motherboard. This add-on card links the computer to
the server by way of a network interface.
Network Cable - A cable that connects the NIC to
the router/hub/switch.
Power Cable - A power cable is used to connect
the power supply of the computer to anAC outlet.
USB - USB (Universal Serial Bus) is a standardized
cable that connects computer peripherals such as
keyboards, pointing devices, cameras, printers, disk
drives, and much more to a computer.
Continued on Page 13
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Computers ... Continued from Page 12
Why does a computer need software?
A computer without software is like a body without
a brain. The body has a purpose, but has no idea what
that may be. Software is a bridge between the user and
the computer that allows our commands to be carried
out. Without software, we would have to create a new
program for each task we wished to carry out.

interesting challenge.Approach this challenge as if you
were a detective gathering information, making a hypotheses, exploring and testing your hypotheses, and when
you’ve solved one case, looking forward to the challenge
of the next.

How is using a microcomputer different from
using a mainframe?
A microcomputer is a unit built to support a single
user at a time, while a mainframe is a “bank” of computers built to support the microcomputers or any other
computer driven mechanical uses.

Interesting Internet Finds

For example, a microcomputer is called a “PC” or
Personal Computer. You can find this type of computer
in a home or office environment, while a mainframe is
the power behind a business or government’s computer
needs. “Micro or Personal means small of stature while
“Main” means primary or powerful.
Help, Tutorials, & Manuals
No class can ever teach you all you could ever
know about using computers or everything about one
software package. Accessing the help in Microsoft
Windows software will provide reference information.
You may access this by going to the menu bar and
selecting help or by pressing the F1 key. Type in your
question, and if it isn’t answered, select the index in the
help feature. Type your question again, and scroll
through the selection until you find a word that may
match your question. Select this word and select
“Display”. If this doesn’t meet your needs, you may find
Google search as an excellent source of help.
Learning to use computers is a challenging activity,
heightened by the fact that computer hardware and
software change rapidly. Just when you master one
software package, a new one appears. You are challenged again to learn something new. Happily, you will
discover that many concepts you have learned previously carry over to new hardware and software technologies. To maintain a good attitude about computers,
it is important to view the learning process itself as an
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Steve Costello, President/Editor, Boca Raton Computer
Society, Inc., FL
November 2012 issue, Boca Bits
www.brcs.org
http://about.me/sefcug
editor (at) brcs.org

In the course of going through the more than 200
news feeds in my Google Reader, I often run across
things that I think might be of interest to other user group
members.
The following are some items I found interesting
during the month of October 2012.
(Long URLs shortened with the Google URL
shortener http://goo.gl/ )
The Best Three Public Domain Clipart Galleries
http://goo.gl/DGNMq
5 Best FeedBurner Alternatives For Your
WordPress Blog
http://goo.gl/dP5Da
HTG Explains: HowAntivirus Software Works
http://goo.gl/Yjp38
Why I bought my wife a Mac
http://goo.gl/FDzmM
How To Get Free Movies Online - Legally
http://goo.gl/jc8Nw
Secrets for successfully narrating a presentation
http://goo.gl/USl4m
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Lost on a rainy night, a nun stumbles across a
monastery and requests shelter there.
Fortunately, she's just in time for dinner and was
treated to the best fish and chips she had ever tasted.
After dinner, she went into the kitchen to thank the
chefs. She was met by two of the Brothers.
The first one says, "Hello, I am Brother Michael,
and this is Brother Charles."
"I'm very pleased to meet you," replies the nun.
I just wanted to thank you for a wonderful dinner.
The fish and chips were the best I've ever had!
Out of curiosity, who cooked what?"
Brother Charles replied, "Well, I'm the fish friar."
She turned to the other Brother and said, "Then you
must be...?"
"Yes, I'm afraid so--I am the chip monk."

“Programming today is a race between software
engineers striving to build bigger and better idiot-proof
programs, and the Universe trying to produce bigger and
better idiots. So far, the Universe is winning.”
- Rich Cook
“Inanimate objects can be classified scientifically into
three major categories; those that don’t work, those
that break down and those that get lost.”
- Russell Baker
“Man invented language to satisfy his deep need to
complain.”
- Lily Tomlin
“My parents didn’t want to move to Florida, but
they turned sixty, and that’s the law.” -Jerry Seinfeld
“The day I worry about cleaning my house is the day
Sears comes out with a riding vacuum cleaner.” Roseanne

Lotus 1-2-3 turns 30:
And, unlike the rivals, 1-2-3 wasn’t hard to understand or difficult to use. There were jargon-free
prompts, explanatory messages, and fail-safe mechanisms in case of mistakes. 1-2-3 was the first program
to make full use of the IBM keyboard enabling commands via the F and slash keys. 1-2-3 packed a tutorial
package and context-sensitive help – all features that
had one reviewer enthusing about 1-2-3’s attention on
“human engineering.”
Read more:
http://tinyurl.com/auum9w6

Have you watched
“Person of Interest”
Here’s the real life version
http://www.wimp.com/nextsurveillance/

Our necessities are few but our wants are endless...
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Brevard Users Group Membership Application
First Name _________________________________

Last Name _________________________________

Address ___________________________________

City ______________________________________

Home Phone ________________________________

State _______ Zip + 4 ________________________

Family Membership $24.00 with e-mail newsletter.

E-mail Address ______________________________

Special Interest Groups
Afternoon Meeting

BUG Club Information
BUG E-MAIL LIST

An afternoon meeting is held on the first
Monday of the month at 2pm, in One Senior
Place, 8085 Spyglass Hill Rd, Viera.

Monthly Meeting & Windows SIG
Meets 6:00 PM
On the First Wednesday at the Melbourne
Library, 540 E, Fee Ave.

To be included in the BUG E-Mail roster, send
an E-Mail to Larry French at:
president@bugclub.org.
We will need your full name, E-Mail address and
your BUG membership number. You will then
receive notices and updates on BUG activities,
special events, changes to schedules, etc.
BUG Officers

To be updated

WINDOWS & LINUX SIG

Meets on the 4th Thursday at:
Westwood Condominium Clubhouse
600 N. Wickham Rd, elbourne
South of Sarno Rd, across from the new IRS
building. Parking only allowed in spaces marked
G for Guest

NEWSLETTER SIG
Meets on the second Saturday before
and after the BUG monthly meeting.
Place is Jim Townsend’s home.
Call 728-5979 for directions.

TINKERS SIG
Meets the Third Sunday, at Bob Schmidt’s house.
Call 952-0199 to verify meeting and directions.
E-mail: rschmidt@cfl.rr.com
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Advertising Rates
4 Months 8 Months 12 Months
Full Page $160.00 $ 305.00
$ 440.00
Half Page $ 85.00 $ 162.00
$ 232.00
Qtr Page $ 45.00 $ 86.00
$ 123.00
Bus Card $ 25.00 $ 48.00
$ 68.00

Moving ?
Don’t miss out on any issues of the BUG Newsletter
Send your new address to:
Brevard Users Group Att: Treasurer
PO Box 2456
Melbourne, FL 32902-2456
And e-mail to the Newsletter and Treasurer at:
newsletter@bugclub.org
treasurer@bugclub.org
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